
 
 

  

 

 

  

ARMS 
User Handbook 

Sylwia Cieplak 
January 2022 

Prepared by: 
The Salvation Army Information Technology Department 
 



i | P a g e   
 

Table of Contents 
Prepared by: The Salvation Army Information Technology Department  .................................................................................   

Overview ...................................................................................................................................................................................... 1 
Logging On ............................................................................................................................................................................... 1 
The Banner ............................................................................................................................................................................... 1 

User Access Levels ....................................................................................................................................................................... 2 
MU Management ......................................................................................................................................................................... 2 

Search for Ministry Unit ........................................................................................................................................................... 3 
Activate MU ............................................................................................................................................................................. 3 
Remove Ministry Unit Filter ..................................................................................................................................................... 4 
Remove Ministry Unit from Review List .................................................................................................................................. 4 
Change Ministry Unit Name ..................................................................................................................................................... 4 
Clustered Groups ..................................................................................................................................................................... 5 

Chapters Maintenance ................................................................................................................................................................ 5 
Add New Chapter ..................................................................................................................................................................... 6 
Add a Supplemental Chapter for existing chapter ................................................................................................................... 6 
Change supplementary name .................................................................................................................................................. 7 
Delete supplementary ............................................................................................................................................................. 8 
2-Chapter Configuration: ....................................................................................................................................................... 25 
Edit Chapter ............................................................................................................................................................................. 8 
Delete Chapter ......................................................................................................................................................................... 9 
Add New Section ...................................................................................................................................................................... 9 
Edit Section ............................................................................................................................................................................ 11 
Delete Section ........................................................................................................................................................................ 12 
Add New Standard ................................................................................................................................................................. 12 
Edit Standard ......................................................................................................................................................................... 14 
Delete Standard ..................................................................................................................................................................... 15 
Make Chapter Mandatory ..................................................................................................................................................... 16 
Remove Mandatory Status from Chapter .............................................................................................................................. 16 

Review Process Management - Review ..................................................................................................................................... 17 
Reviews List ............................................................................................................................................................................ 17 
Schedule Review .................................................................................................................................................................... 18 
Schedule Review Date Conflict .............................................................................................................................................. 20 
Change Review Scheduled Date ............................................................................................................................................ 20 
Delete Review Scheduled Date .............................................................................................................................................. 20 

Chapter Configuration ............................................................................................................................................................... 21 
Configure Chapters ................................................................................................................................................................ 21 
Assign Single Chapter to Ministry Unit at Time ..................................................................................................................... 23 
Assign Multiple Chapters to MU at Time ............................................................................................................................... 23 



ii | P a g e   
 

Assign Mandatory Chapters ................................................................................................................................................... 23 
Assign Multiple Instances of Same Chapter ........................................................................................................................... 24 
Assign Chapter Alias ............................................................................................................................................................... 24 
Remove Single Assigned Chapters ......................................................................................................................................... 27 
Remove Multiple Chapters from Ministry Unit at Same Time ............................................................................................... 27 
Remove Mandatory Chapters ................................................................................................................................................ 28 
Remove All Chapters from MU at Same Time ....................................................................................................................... 29 
Remove Chapters with Ratings .............................................................................................................................................. 30 
Remove Chapters When Review is Closed ............................................................................................................................. 30 

Select Review Team ................................................................................................................................................................... 30 
Assign Team Leader ............................................................................................................................................................... 30 
Add Reviewer(s) to Team ....................................................................................................................................................... 31 
Team Member Has Conflicting Reviews ................................................................................................................................ 32 
Add Action Plan Reviewer(s) .................................................................................................................................................. 32 
Add Action Plan Planner ........................................................................................................................................................ 33 
Remove Team Leader if no scores are entered ..................................................................................................................... 34 
Remove Team Reviewer if no scores are entered ................................................................................................................. 34 
Remove Action Plan Reviewer if no scores have been entered ............................................................................................ 35 
Remove Action Plan Planner if no scores have been entered ............................................................................................... 36 
Change Team Leader/Team Reviewers/Action Plan Reviewers ............................................................................................ 36 
Remove Team Leader/Team Reviewers if scores have been entered ................................................................................... 37 
Remove Action Plan Reviewers or Planners if Action Plan Submitted .................................................................................. 37 

Assign Reviewers to Chapters .................................................................................................................................................... 37 
Assign Multiple Reviewers to Same Chapter ......................................................................................................................... 39 
Reviewer Has Conflicting Reviews ......................................................................................................................................... 40 
Remove Reviewers from Chapters ........................................................................................................................................ 40 
Remove One Reviewer from Chapter that has Multiple Reviewers ...................................................................................... 40 
Remove All Reviewers from All Chapters .............................................................................................................................. 41 
Remove Team Reviewers from Review After Assigned to Chapters ..................................................................................... 41 

Document Templates................................................................................................................................................................. 42 
Add Templates and Create List of Required Documents ....................................................................................................... 42 
Edit Required Document ........................................................................................................................................................ 43 
Remove Existing Template File .............................................................................................................................................. 44 
Replace Existing Template File ............................................................................................................................................... 44 
Inactivate Required Document .............................................................................................................................................. 45 
Delete Required Document ................................................................................................................................................... 45 

Add Documents ......................................................................................................................................................................... 46 
Download Template Documents ........................................................................................................................................... 46 
Submit Review Documents .................................................................................................................................................... 46 
View Submitted Documents .................................................................................................................................................. 47 



iii | P a g e   
 

Remove Submitted Document............................................................................................................................................... 47 
View Documents ........................................................................................................................................................................ 48 
Ratings ....................................................................................................................................................................................... 49 

Access Ratings ........................................................................................................................................................................ 49 
Complete Ratings ................................................................................................................................................................... 50 
Print Details ........................................................................................................................................................................... 51 
Submit Ratings ....................................................................................................................................................................... 52 
Approve Ratings ..................................................................................................................................................................... 53 

Review Scores ............................................................................................................................................................................ 53 
Access Scores ......................................................................................................................................................................... 54 

Release ....................................................................................................................................................................................... 54 
Action Plan ................................................................................................................................................................................. 55 

Add Action Planner ................................................................................................................................................................ 55 
Create Action Plan ................................................................................................................................................................. 56 
Ministry Unit Submit Action Plan ........................................................................................................................................... 57 
Divisional Approval of Action Plan ......................................................................................................................................... 58 
Divisional Decline of Action Plan ........................................................................................................................................... 60 
Resubmit Action Plan to DHQ ................................................................................................................................................ 61 
THQ Approval of Action Plan ................................................................................................................................................. 62 
THQ Decline of Action Plan .................................................................................................................................................... 63 
Resubmit Action Plan to THQ ................................................................................................................................................ 64 
Download Action Plan ............................................................................................................................................................ 64 

Action Plan Notes ...................................................................................................................................................................... 66 
Create Action Plan Notes ....................................................................................................................................................... 66 
Edit Action Plan Notes ........................................................................................................................................................... 67 
View Action Plan Notes .......................................................................................................................................................... 68 
Print Action Plan Notes .......................................................................................................................................................... 68 
Delete Action Plan Notes ....................................................................................................................................................... 69 

Close Review .............................................................................................................................................................................. 69 
Conditional Pass ......................................................................................................................................................................... 70 

Requirements of a Conditional Pass ...................................................................................................................................... 70 
Accept Conditional Pass ......................................................................................................................................................... 70 
Conditional Review Process ................................................................................................................................................... 71 
Decline Conditional Pass ........................................................................................................................................................ 72 

Schedule Tracking ...................................................................................................................................................................... 72 
Access Schedule Tracking ...................................................................................................................................................... 72 

Reports....................................................................................................................................................................................... 73 
Ministry Unit Reports............................................................................................................................................................. 74 
Summary ................................................................................................................................................................................ 76 
Business Intelligence Reports ................................................................................................................................................ 77 



iv | P a g e   
 

Print Reports .......................................................................................................................................................................... 79 
Create Live Reports ................................................................................................................................................................ 80 

Connect to a SQL Data Source ........................................................................................................................................... 80 
Insert a Pivot Table ............................................................................................................................................................ 82 

Calendar ..................................................................................................................................................................................... 85 
Calendar Controls .................................................................................................................................................................. 86 

Sort ............................................................................................................................................................................................ 87 
Filters ......................................................................................................................................................................................... 87 

Text Box Filters....................................................................................................................................................................... 87 
Remove Filter ......................................................................................................................................................................... 88 

Page Controls ............................................................................................................................................................................. 89 
Move through Individual pages ............................................................................................................................................. 89 
Go To Desired Page ................................................................................................................................................................ 89 
Go to First or Last Page .......................................................................................................................................................... 89 
Page Size ................................................................................................................................................................................ 89 
Items and Pages Displayed .................................................................................................................................................... 89 

Sign Out ..................................................................................................................................................................................... 90 
 



 

1 | P a g e   
 

Overview  
The Accreditation Review Management System (ARMS) Program is used to manage, schedule, and monitor the 
Social Services accreditation process. The Salvation Army’s internal accreditation process provides an 
assessment of social service ministry units using standards which reflect organizational policy, legislative 
requirements, and best practices. These standards describe processes and systems in the areas of governance, 
employee relations management, facility management, spiritual and religious care, and program delivery. 
 
The program is accessible via a secure internet connection through a server located at THQ. 

Logging On 
 
 
 
 

 
 
 
 
 
 
 

    

The Banner 
The common functions for ARMS are contained in the top banner (as shown below). 

 

1. Open My Army > http://myarmy.can.salvationarmy.org 
2. Scroll down to Applications 
3. Click on the ARMS tile     

4. Type your username 
Your username has two format options: Firstname.Lastname or Email address 

5. Type your password 
Your password is the same as you use to log in on your computer/laptop 

6. Click Sign In 
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User Access Levels 

There are several levels of access within ARMS for various users; users with different roles and responsibilities 
for the review will have access to different menu items. 

Access Level  Roles 

ARMS Coordinator • THQ social services personnel 
• Oversees TSA Social Services Accreditation Review Program including rating, 

submit, approve, release review and approve action plan after proposed by MU 
• Schedules reviews, assigns chapters for reviews, selects review team and 

assigns chapters to reviewers 
• In charge of all maintenance functions of the application (chapters 

maintenance, review configuration maintenance, review document 
maintenance, & application maintenance) 

Review Scheduler • THQ social services Personnel 
• Schedules reviews  
• Views and updates schedule tracking procedure 

Team Leader • THQ social services personnel 
• Manages the accreditation review process cycle for accreditation reviews of 

ministry units that have been assigned to them 
• View documents submitted by MU 
• Able to re-select review team and reassign chapters to reviewers 
• Submits and approves completed ratings for reviews assigned to them 

Area 
Commander/Divisional 
Social Services 
Secretary 

• DHQ personnel 
• Review team member for reviews of ministry units that are under their 

jurisdiction 
• Submit completed ratings for chapters assigned 
• Approves & monitors resulting action plans; DHQ may also assign another DHQ 

approver for the action plan 

Reviewer • Submits completed ratings for chapters assigned to them 
• Views documents submitted by MU 

MU Personnel • Manages all documents and information that are required for their accreditation 
review process 

• Downloads template documents 
• Submits required documents prior to the accreditation review 
• Responsible for the development of the corresponding action plan resulting 

from the review 

MU Management 

In order for Ministry Units to appear in the Review Process Review List, the ministry unit must be active. The 
ARMS Coordinator is the only person who can activate or deactivate a Ministry Unit for the review list. 

  
  

Click Admin>Ministry Units 
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Search for Ministry Unit 
To locate a ministry Unit in the list, you will need to search for the Ministry Unit. You can search for Ministry Unit 
based on MU Name, Address, City, Postal Code or Division. You can limit the display list by selecting to display 
all MUs, ARMS Only, and SAMIS Only selected. You can search using one field or using multiple fields; you can 
use part of words or entire words.  

All – displays all ministry units within the territory 
ARMS Single – displays ministry units that have been selected for accrediation review 
ARMS Grouped – displays Ministry Units that have been grouped as one entity 
SAMIS Only – displays list of ministry units that have not been selected for accrediation review 
 
                                                                                                                                                         

 
 
                                                      

 
 
                                                                      

 

Activate MU  
To find an inactive Ministry Unit, use the filter for SAMIS Only. Locate the desired Ministry Unit using search 
criteria and click to activate the Ministry Unit so that it is available and visible in the Workflow, Reviews display list. 

  

Example of search using ARMS criteria SAMIS Only 

Example of search using multiple criteria and filter for SAMIS Only selected 

Example of search using single criteria and filter for SAMIS Only selected 
Type into desired search field 

Press ENTER on your keyboard 
 

Type into desired search field 

Press ENTER on your keyboard 
 

Click check box to activate MU for review 
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Remove Ministry Unit Filter 
To remove the filter, you can highlight the contents of the filter, and press Delete on the keyboard, or you can click 
the x in the filter field. Then press Enter on keyboard. Likewise, to reset a drop-down filter, you can click drop-
down and select All. 

                                                                     

Remove Ministry Unit from Review List 

1. Locate the desired Ministry Unit using search criteria outlined above in Search for Ministry Unit  
2. Click to uncheck the desired Ministry Unit to remove from the MU review list 

 

Change Ministry Unit Name 

The Ministry Unit names and locations are drawn from SAMIS. The ARMS Coordinator can change the name of a 
Ministry Unit to better reflect the actual Ministry Unit name if required. 

Click Admin>Ministry Units 

 

 

You will get a confirmation message of the new name. 

 

New MU Name is saved but SAMIS name remains same. 

Highlight filter contents Click X 

Click to remove 

Drop-down>All 

Click x to remove current MU Name 

Type new MU Name 



 

5 | P a g e  

Clustered Groups 
Clustered groups refer to Ministry Units that are linked as one entity. The Ministry Unit are related and would have 
one accreditation review process. Clustered groups are created by the IT department within the ARMS 
application. If a unit is already in an active review, they cannot be made part of a group until the review is 
completed. If a Ministry Unit had a review in the past as a single unit, they can still become part of a clustered 
group, but any past reviews remain in the history if the single unit. 
To see the membership of a clustered group, hover over the Ministry Unit in the reviews list. 

 

Chapters Maintenance 

Chapters, sections, and standards are used in ARMS as the basis for ratings in accreditations. There are four 
core chapters that apply to all units being reviewed and are considered mandatory. The remaining chapters are 
program related and are used as determined by the specific programming of the ministry unit. In some units one 
program chapter might be used, while in other units several may be applicable. 

A chapter is divided into sections. Each section covers a specific topic. Each chapter has numerous sections. To 
create a section, the associated chapter must be created first. 

A section has numerous standards. The standard outlines the expectations and requirements related to that item, 
whether it is a document, a process, or a system that should be in place. The procedure directs the reviewer on 
how compliance will be determined. It may direct to a document or file to look in, a person, or identify specific 
steps to take. Each standard has a three-digit item number which identifies the chapter, the section, and the 
standard. To create a standard, the associated chapter and section must be created first. 

If a review has been scheduled for the year, you will be unable to create any new chapters, sections, or standards 
for that calendar year. You will see this message. 

 
  

Clustered group 

Units in clustered group 
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If there are no reviews scheduled for the year, you can proceed to create, modify, or delete chapters, sections, 
and standards. 

 

Add New Chapter  

When a new chapter is created, the chapter ID is set at the next in the sequence. 

 

 
 

If the year has a review already scheduled, you will not be able to create any new chapters. 

 

Add a Supplemental Chapter for existing chapter 
This feature only available to the Application Coordinator role 

1. Open Admin>Chapters 
2. Click desired chapter to make the supplemental chapter entry 

Click Admin>Chapters 
 

1. Click on Add Chapter to enable adding of the chapter 
 

2. Type a name for the chapter 
3. Check if the chapter is a required chapter 
4.    Click Save 
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Change supplementary name 
1. Open Admin>Chapters 
2. Click desired chapter to make the supplemental chapter name edit 

 

 

3. Click Add Supplementary 
 

4. Enter Supplementary Chapter Name 
5. Click Save and Close 
 

3. Click to open Supplementary chapter  
4. Click in the name section to renter/ change name 
5. Save and Close 
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Delete supplementary 
1. Open Admin>Chapters 
2. Click desired chapter to delete the supplemental chapter 
3. Click on the garbage can to delete 

 
 

Edit Chapter 
Open Admin>Chapters 

Chapter # can not be edited. Automatically populates by sequence 

 
      

1. Select/Click the chapter to edit 
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Delete Chapter 
If you delete the chapter, all sections and standards associated with that chapter will also be deleted. 

Open Admin>Chapters 

         
 

4. Please note a confirmation message will come up. Click OK to proceed with deleting chapter 

 
 

Add New Section 
Open Admin>Chapters 

2. Click on Chapter Name to type a new name 
3. Checkmark to select mandatory or remove 

checkmark from mandatory 
4. Click Save Changes 
 

2. Highlight (click on) chapter to delete  
3. Click on Delete Selected 
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Section ID picks up the next number in the sequence. 

 

 
 

6. Please note a confirmation message will come up. Click OK to proceed with creation of the Section 

 

2. Select/Click the chapter you require a New Section created within 

3. Click Add New Section 

4. Enter name of Section 

5. Click Save 
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Edit Section 
Open Admin>Chapters 

 
The only editable sections is the Section Name. The Section # is automatically populted as per sequence and is 
not editable. 

 

 

         
 

4. Please note a confirmation will come up. Click OK to Save Changes. 

 

2. Click on name field and re-enter a new name 

1. Select/Click the chapter to enable editing 
 

3. Click Save 
Changes 
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Delete Section 
Open Admin>Chapters 

 

 
 

4. Please note a confirmation of deletion will come up. Click OK to confirm. 

 
                                               

Add New Standard 

1. Open Admin>Chapters 

3. Click Delete 

1. Select/Click the chapter in which the Delete Section resides 
 

2. Click to highlight the Section that requires deletion 
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3. Click Add Standard 

2. Select/Click the chapter where the Standard will be created 
 

2. Click title of section 
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Please note a confirmation message of creation will come up. Click OK to confirm. 

 
 

 

The standard ID will be created with the next number in sequence. 

 
 

Edit Standard 
Open Admin>Chapter 
Click desired chapter 
Click desired section  

4. Open the drop-down menu to select 
a Standard Point weight 

5. Select which pertains to this 
Standard 

6. Click Save 
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Please note a confirmation message will come up. Please click OK to continue. 

 

Updated. 

 
 

   

Delete Standard 
Open Admin>Chapters 

Click desired chapter 

Click desired section 

1. Double Click on Standard required to edit 

2. Update Standard Point Weight 
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**Please note a confirmation message will come up. Please click OK to continue. 

 

 

Make Chapter Mandatory 
There are mandatory chapters in ARMS that each Ministry Unit must complete.  

1. Open Admin>Chapters 
2. Click to open which Chapter will be Mandatory 
3. Click Mandatory to add checkmark to desired chapter 
4. Click “Save Changes” 

 
 

Remove Mandatory Status from Chapter 
A Chapter may be removed from mandatory status.  

1. Open Admin>Chapters 
2. Click to check desired chapter to remove check from mandatory  
3. Click Mandatory to remove checkmark to desired chapter 
4. Click “Save Changes” 

1. Highlight desired Standard to delete 
2. Click Delete Standard 

 



 

17 | P a g e  

  
 

Review Process Management - Review 

Review process management provides tools for organizing ministry unit reviews. THQ personnel are responsible 
for scheduling the review process. Once a Ministry Unit has a review scheduled in ARMS, it will be displayed in 
the reviews list.  

The Ministry Unit undergoing the review process provides the required information and documents for the review. 
If there are standards that do not meet accreditation expectations, the ministry unit will design an action plan to 
address those standards. 

Reviews List 
All members of the review team will be able to view the reviews list. However, you will only see the reviews for the 
Ministry Units assigned to you in the review list once the review has been scheduled in ARMS. 

  

 

Click Workflow>Reviews 
 

Using the search filters, locate desired MU 
 

Click desired MU 

Search filters 
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Schedule Review 

 

Locate the desired Ministry Unit in the list using the desired filter criteria. 

  
 
You will be able to see from the reviews list if the Ministry Unit currently has a review scheduled as you will see a 
date under review start date. 

 

If Ministry Unit does not have a scheduled review, you will proceed to schedule the review for the Ministry Unit. 
Only an ARMS Coordinator or Review Scheduler can initially schedule reviews. Once a review has been assigned 
to a Team Leader, that individual can reschedule the review. 

  
  
If the Ministry Unit selected does not have a scheduled review, the default date on the calendar is blank. Locate 
the desired date on the calendar. 

Search filter. Use filter to locate desired MU 

Click Workflow>Reviews 
 

1. Click desired Name 

2. Click Schedule  

MU with scheduled review 
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When you close Schedule Review window and return to the Reviews List, you will see the Start and end date for 
the review. 

 

If you try to schedule a review with a start date earlier than the end date you will see this message. 

 

  

1. Type the desired date as MM/DD/YYYY or click to 
select the date from the calendar to set review start 
date 

2. Complete the exact process for the review end date 
3. Click Save 

After you click save, you will get this 
confirmation message. 
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Schedule Review Date Conflict 

If there is already a review scheduled for the date you selected, you will get a validation message.   

                                                                                                                 

Change Review Scheduled Date 

To change the review date for a MU: 
1. Locate and click the desired Ministry Unit to select it in Reviews List 
2. Click Schedule to open the calendar 

 
  

          

Delete Review Scheduled Date 

 

Click Cancel to select a different review date or 
click Yes to accept the requested date 
 

The default date is currently the date of the 
scheduled review for the selected Ministry Unit 
3. Type or select from calendar the desired start and 

end dates for the review 
4. Click Save 

The date for the review cannot be deleted if there 
have been scores recorded for the review 
 
 You will see a message at the bottom of the review 
stating you cannot re-schedule the review; delete 
button is also greyed out and cannot be accessed 

If the review is in progress, you will not be able to change the 
scheduled date and will get a message that the review cannnot be re-
scheduled 
Click Close to close schedule window 
If the review is not in progress, the new scheduled date will be saved 
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If there aren’t any scores recorded, you will be able to delete the review from the calendar. 
1. Select desired Ministry Unit 
2. Click Schedule 
3. Click Delete 

 

 
The scheduled review is removed from the calendar and updated as having no start and end date for review in 
review list. 

Chapter Configuration 
The chapters cannot be selected for a Ministry Unit before the review is scheduled; if you try to assign chapter 
prior to the review being scheduled, you will receive the error message below. Proceed to schedule a review date. 

 
Only the ARMS Coordinator can initially assign chapters to a review, but once a Team Leader is assigned, they 
are able to reassign the chapters. 

Configure Chapters 

When you assign chapters to a Ministry Unit review, all mandatory chapters must be added or you will not be able 
to save the chapters. If you try to save without adding all mandatory chapters, you will get this message. Continue 
to add all mandatory chapters to the review. 

 

Scheduled review date 

4. Click Yes to confirm delete 

Click OK to message 
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You will get a message that the selected chapters have been saved. 

 
Click Close button to return to Reviews List. 
You will see on the Review List pages the chapters that have been assigned for the review. 

 

If you do not add all desired chapters for review at same time, but add another chapter after you have saved 
chapter configuration, you will get a different message when saving the chapter configuration stating which 
chapters have been added. 

 

1. Click desired MU 

2. Click Chapters 

3. Click  desired chapter from Available 
chapters list in left pane 

4. Click single arrow pointing to right to send 
chapters to Assigned Chapters list 

5. Click Save 

Assigned chapters 
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Assign Single Chapter to Ministry Unit at Time 

Select the desired Ministry Unit and open Chapters Configuration. All mandatory chapters are required to be 
added in order to save chapter configuration. 

 

 

Assign Multiple Chapters to MU at Time 

 

If you assign some chapters and save the configuration and then return and assign more chapters to the review, 
you will get a different message when you save the added chapters. See Ok message above. 

Assign Mandatory Chapters 

In chapter configuration, mandatory chapters are designated with ***. These chapters are required to be assigned 
to every scheduled review within the territory. If all mandatory chapters are not assigned to a review, you will get a 
warning message. You cannot save without assigning all mandatory chapters. Click OK to dismiss message and 
proceed to assign all mandatory chapters to the review. 

1. Use the mouse and ctrl key to select 
chapters that are not listed sequentially; use 
the mouse and shift key to select chapters 
that are listed sequentially 

2. Click arrow 
3. Click Save 
4. Get message confirming saved chapters 

1. Click desired available chapter 
2. Click arrow 
3. Click Save 
4. Get message confirming saved chapters 
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Assign Multiple Instances of Same Chapter 

 

 

Assign Chapter Alias 
To change the name of a chapter, that chapter must already be assigned to the review. A chapter name can be 
personalized to refer to a specific program or facility in a review where there is more than one instance of the 
same chapter. 

                        
 
 

1. Click desired chapter in assigned chapters 
2. Click assign Chapter Alias 
3. Type a name for the chapter 
4. Click Save 

1. Click desired available chapter 
2. Click arrow  
3. Repeat steps 1 and 2 to assign same 

chapter again 
4. Click Save 
 

Multiple instances same chapter 
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Chapter Configuration: 
 

• Select chapter for Edmonton review (select chapters 1,2,3,4) 

•  
NOTE: 
Review in 2022, chapter 3 has a supplementary, if you hi-light chapter 3 “Manage Supplementary” 
button is enabled. 

 
Click the manage Supplementary Chapter button, will pop up a dialogue: 
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You have option to add Supplementary Chapter, we can skip this in this review  
 

• Select chapter for Hamilton review (select chapters 1,2,3 and supplementary, 4 and then add 
supplementary for chapter 3) 

 
 NOTE: 
Review in 2022, chapter 3 has a supplementary, we add a supplementary by click ADD 
Supplementary chapter button. The default supplementary chapter ID is 3a, chapter name is 
“Facilitya”, next one is 3b, “Facilityb” … 

You can change the name of the supplementary of the review or remove the supplementary from the 
review before the review is submitted. 
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Remove Single Assigned Chapters 

 
Single instances of mandatory chapters cannot be removed. Multiple instances of the same mandatory chapter 
can be removed, and all mandatory chapters can be removed at same time. 

Remove Multiple Chapters from Ministry Unit at Same Time 

 
You will get a message stating the chapters have been removed; you cannot remove mandatory chapters if it has 
only one instance of the chapter. You will get the message below. Click OK to dismiss message.  

                                      
  

1. Click desired chapter 

3. Click save 

1. Use the mouse and ctrl key to select 
chapters that are not listed sequentially; use 
the mouse and shift key to select chapters 
that are listed sequentially 

3. Click save 
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Remove Mandatory Chapters 
You are able to remove mandatory chapters from a review but certain requirements must be met. 
If there are multiple instances of the mandatory chapter, you can remove those. 

1. Click the desired chapter to be removed 
2. Click arrow pointing left 
3. Click Save 

 
You will get a message that the multiple instance of the mandatory chapter has been removed. 

 
However, if there is only one instance of the mandatory chapter in assigned chapters, you will not be able to 
remove one mandatory chapter; you will have to remove all mandatory chapters in order to save the chapter 
configuration.  

1. Click all four mandatory chapters using the ctrl+shift key 
2. Click the arrow pointing left 
3. Click Save 
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You will get a confirmation message that the chapters have been deselected. 

 
You will get this message if you select less than all mandatory chapters; click OK to dismiss message and 
continue to remove all mandatory chapters. 

  

Remove All Chapters from MU at Same Time 

 
You will get a message stating the chapters have been deselected. All mandatory chapters must be removed at 
once or you will get a message as outlined above “missing mandatory chapters”. 

 

  

1. Use the mouse and shift key to 
select all the chapters  

3. Click save 
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Remove Chapters with Ratings 
Any chapter that has ratings entered, submitted, or approved cannot be removed from the review. You will see a 
msessage similar to one of the messges below. 

                

Remove Chapters When Review is Closed 
If a review has been closed, you cannot modify the chapters assigned to the review. You will get the message 
below. 

 

Select Review Team  

Each review that is scheduled has a review team assigned to it. In order to assign a review team to the Ministry 
Unit, there must be a scheduled review. If there is no scheduled review, you will receive this message. 

 

Select desired Ministry Unit from list and confirm there is a review scheduled for the Ministry Unit. Only the ARMS 
Coordinator and Team Leader can select team members to assign to a review. 

Assign Team Leader 
Every review is assigned a team leader. You can save the team leader without having assigned reviewers or 
action plan reviewers to the review; however, you will receive a message reminding you to select reviewers. 

 

Click Ok to dismiss message 
and proceed to schedule a 
review for Ministry Unit 

1. Select MU with scheduled review 

2. Click Teams 
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Add Reviewer(s) to Team 
Reviewers must be added to each review. You can add one reviewer at a time, or you can add multiple reviewers 
by using the mouse and ctrl key or the mouse and shift key. 
Choose the desired Ministry Unit and click Teams button. 

 
If you try to save the the reviewer team without having set a team leader, you will get the message below and the 
team will not be saved. Proceed to select a review team leader. 

 
  

1. Clik drop-down to select team leader 
2. Click desired available reviewers and click arrow to 

assign selected reviewers  
3. Click Save Review Team 
4. Get confirmation message that team has been saved 

Use the mouse and ctrl key to select multiple reviewers 
that are not listed sequentially; use the mouse and shift key 
to select multiple reviewers that are listed sequentially 
 

3. Click drop-down to select team leader 
4. Click Save Review Team 
5. Get confirmation message team leader 

saved but reviewers still need to be 
selected 
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Team Member Has Conflicting Reviews  
If a team member has been assigned to two reviews at the same time, you will get a notification message when 
you try to add that team member to a second review. You are still able to assign the team member to multiple 
reviews at the same time  

 
Add Action Plan Reviewer(s) 

                                                   
You can save a team leader and a review team without selecting the action plan reviewers at the same time. You 
can save the review team without having saved the action plan reviewers and vice versa. 

If you try to save the action plan reviewers without having set a team leader, you will get the message below and 
the action plan reviewer will not be saved. Proceed to select a review team leader. You will get a confrmation 
when the action plan reviewer has been added successfully. 

1. Open desired ministry units to teams  view 
2. Click to check desired available action plan reviewers  
3. Click Save Action Plan Team 
4. Get confirmation message that action reviewer has 

been added 
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When you close select review team window and return to the review list, you will see the status indicating the 
reviewers have been selected for the review. 

 

Add Action Plan Planner 
The action plan planner is visible on the right under Planners. There may be one or more than one action plan 
planners. 

 

 

1. Open desired ministry units to teams  view 
2. Click to check desired available action plan planners 
3. Click Save Action Plan Team 
4. Get confirmation message that action planner  has been added 

In order to save action plan planner, a 
team leader must also be selected and 
saved 
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Remove Team Leader if no scores are entered 

The team leader cannot be removed if there are team reviewers and action plan reviewers selected. If all team 
reviewers and action plan reviewers are removed from a review, the team leader is automatically removed. If you 
try to remove the team leader while there are still team reviewers and action plan reviewers assigned to the 
review, you will get the message below. 

 

Remove Team Reviewer if no scores are entered 

This is the ideal time to remove reviewers as there are no restrictions. 

1. Click to select the desired Ministry Unit from the reviews list 
2. Click Teams 

 

 

  

3. Click desired reviewer in available reviewers 
4. Click arrow pointing left 
5. Click Save Review Team 
 
You will get a confirmation message that the reviewer has 
been removed 
 



 

35 | P a g e  

If whole team is removed (including reviewers and planners), the team leader is automatically removed from 
the review. 

  

Remove Action Plan Reviewer if no scores have been entered 

This is the ideal time to change or remove action plan reviewers as there are no restrictions. 

1. Click to select the desired Ministry Unit from the reviews list 
2. Click Teams 

 

  

3. Click to remove check from desired action plan reviewer 
4. Click Save Action Plan Team 
 
You will get a confirmation message that the action plan 
reviewer has been removed 
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If all reviewers and action plan approvers have been removed from the review, the team leader will also be 
removed.    

  

Remove Action Plan Planner if no scores have been entered 

 

Change Team Leader/Team Reviewers/Action Plan Reviewers 
If no scores have been entered, you are able to change the team leader as well as the team reviewers and action 
plan reviewers. 

Select drop-down to select a new team leader; click Save Team Review 

 
Remove team reviewers by selecting the name in selected reviewers and clicking arrow pointing left to assign to 
available reviewers. Select new team reviewers in available reviewers and click arrow pointing right to send to 
selected reviewers. 

Click Save review Team; you will receive a confirmation message as below 

1. Click to select the desired Ministry Unit from the reviews list 
2. Click Teams 
3. Click to remove check from desired action plan planners 
4. Click Save Action Plan Team 
 
You will get a confirmation message that the action plan planner has 
been removed 
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Remove the check from desired action plan reviewer and click to check the new action plan reviewer. 

Click Save Action Plan Reviewer; you will receive a similar message as below. 

 

Remove Team Leader/Team Reviewers if scores have been entered 

If scores have been entered, the team leader and team reviewers cannot be removed. You will get the message 
below. 

 
Remove Action Plan Reviewers or Planners if Action Plan Submitted 
If the action plan has been submitted, you will be unable to remove action plan reviewers or planners and will get 
a message similar to below. 

 

Assign Reviewers to Chapters 
Only the ARMS Coordinator or the Team Leader can assign chapters to the selected reviewers. The scheduling 
of the review, chapter configuration, and select review team are to be completed before you can assign chapters 
to reviewers.  

Assign reviewers before schedule review                                   Assign reviewers before configure chapters                                                                                                                                                                                                    
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Assign reviewers before review team selected 

 

Once all chapters have been assigned to reviewers, you will be able to save and will receive a confirmation 
message that the chapters assignment has been saved. 

 

 
If reviewers have not been assigned to all chapters, you will not be able to save and will get a message 
confirming that all chapters are not assigned and you cannot save chapters assignment. 

 
  

1. Click desired MU 

2. Click Reviewers 

3. Click desired reviewer in assigned reviewers 
4. Click arrow pointing right 
5. Click Save 
 
You will get a confirmation message  
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When reviewers have been assigned to chapters and have been saved, you will get an updated status on the 
Accreditation Reviews list. 

 

If reviewers have multiple reviews for same time, you will see the red asterisk next to review name when the 
chapters are assigned to the reviewer. 

 

Assign Multiple Reviewers to Same Chapter 

You can assign multiple reviewers to each chapter but all chapters must have at least one reviewer assigned in 
order to save the chapter assignment. If you assign multiple reviewers to the same chapter, each reviewer can 
enter ratings but only one reviewer will be able to submit the ratings. When one reviewer has submitted the 
ratings, the button will be greyed out to all reviewers for that chapter. 

 

If you assign another reviewer to the same chapter after you have saved it originally, you will get this message 
when you save the chapter assignment. Notice the differences from the screen above. 

1. Click desired reviewers in assigned reviewers (use mouse 
& ctrl key to select more than one) 

2. Click arrow pointing right 
3. Click Save 
 
You will get confirmation message of your changes 
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Reviewer Has Conflicting Reviews  
If a reviewer has been assigned to two reviews at the same time, you will get a notification message when you try 
to assign chapters to that reviewer. You are still able to assign the reviewers to multiple reviews at the same time. 

 
Remove Reviewers from Chapters 
The reviewers for chapters can be removed. If there is more than one reviewer assigned to a chapter, you can 
remove all but one reviewer for each chapter. If each chapter has only one reviewer, then all reviewers must be 
removed to save the changes. Once all reviewers have been from chapters, you will get a confirmation message 
that the changes have been saved. 

Remove One Reviewer from Chapter that has Multiple Reviewers 

 

1. Click desired reviewer for each desired chapter in far right that 
has more than one reviewer 

2. Click arrow pointing left 
3. Click Save 
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Remove All Reviewers from All Chapters 
Each chapter must have at least one reviewers assigned to save the chapters assigment. Therefore if you are 
trying to remove reviewers and each chapter does not have at least one reviewer, you will have to remove all 
reviewers to save chapters assignment. 

 

 

Remove Team Reviewers from Review After Assigned to Chapters 
If no scores have been entered, you can remove reviewers from the review even if the reviewers have been 
assigned chapters. The reviewer will be removed from the team as well as from the chapter the reviewer was 
assigned to. You will then have to assign a new reviewer to the chapter that was assigned to the team member 
you removed. If a review has scores entered by the reviewer you are trying to remove, you will not be able to 
remove that reviewer. 

  

1. Click desired reviewer for each desired chapter in far right 
2. Click arrow pointing left 
3. Click Save 

You get confirmation message that the 
reviewer was removed 

You get confirmation message that 
chapter assignment was removed 
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Document Templates 

Required review documents are created by the ARMS Coordinator from the review list, Add Documents option. 
These documents then become available in View Documents for Ministry Units. Local Personnel can download 
any available templates and can submit these templates and all other required documents in View Documents. 
Once the documents are submitted, all other members of the review team will be able to view the completed 
documents under View Documents view. 

 

Add Templates and Create List of Required Documents 
The ARMS Coordinator can add document templates and create the list of required documents for ministry units. 
This list of active documents is then visible to ministry units in Add Documents. If a document is made inactive 
after the date of the scheduled review, it will remain visible to those Ministry Units. However, any Ministry Units 
with reviews scheduled after the document was made inactive will not be able to see the document. 

 

 

          
  

1. Click Admin 

1. Click Add New Document Template 

2. Type a name for the document 
3. Click to check if document is mandatory 
4. Click calendar icon to set an active date 
5. Click select to choose file if there is a desired template  
6. Click Save 

Location of desired template 

2. Click Documents 

You get confirmation message that 
document updated 
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You will see the document in the list. If there is a template associated with the document you will see a file name.  

 

Edit Required Document 

1. Open Admin>Documents 
2. Locate desired document in list 

 

 

You will receive a confirmation message that the document has updated. 

        
  

Template loaded 

3. Click edit 

4. Make desired changes to document by typing over 
required document name, select/deselect 
mandatory and/or modify acticve date 

5. Click Save 
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Remove Existing Template File 
If the document template uploaded needs to be removed, the ARMS Coordinator can complete this process. 
Using the seteps above in Edit Required Documents. open the desired document and place it in edit mode. 

 

You will receive a confirmation message that the document has updated. 

 
Replace Existing Template File 
If the document template uploaded needs to be replaced, the ARMS Coordinator can complete this process. 
Using the seteps above in Edit Required Documents. open the desired document and place it in edit mode. 

 

 

2. Click Save 

3. Click Save 

4. Click Select 

Current template file name 

Current template file name 
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Inactivate Required Document 
Required documents may be made inactive. This means the document will remain in the list for future activation 
but will not be displayed on Submit Documents view. If a required document is inactivated, it will appear in the list 
of past required documents but not in the list for future scheduled reviews. Enter document edit mode following 
the steps listed above in Edit Required Documents List.  

     

Delete Required Document 
If a document is removed from the list of required documents, it will no longer be accessible. If this document is 
required again in the future, it will have to be added again using the steps listed above in Add Templates and 
Create List of Required Documents. 

1. Locate desired document in list 

 

 

                      

2. Click Save 

2. Click delete 

3. Click OK 

If the document has been used for review, you will get this 
message when you try to delete 

 
If the document has not been used for review, the document 
will be removed from required documents 

 

You get confirmation message that 
document updated 

You get confirmation message that 
document uploaded 
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Add Documents 
Ministry units will have to download document templates that are uploaded by ARMS Coordinator; then they 
submit completed templates and other documents required for ARMS. 

 

Download Template Documents 
Document templates can be downloaded from ARMS and saved locally. Templates available to download will 
display “Open Template” message. Only the Ministry Unit Personnel assigned ARMS access can download the 
templates for the Ministry Unit. 

 
 

 

Submit Review Documents 
Ministry units can submit required documents within ARMS. These documents may be a template downloaded 
from ARMS or a document that already exists within the Ministry Unit. Only the Ministry Unit Personnel with 
ARMS access and the ARMS Coordinators can submit required documents for the Ministry Unit. 

 

1. Click Open Template 

1. Click Submit document 

2. Click Add Documents 

1. Click desired MU 

2. Click Save, save as, or open as desired 
 
Choose where you are going to save the template 
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View Submitted Documents 

 
 

 

 

Remove Submitted Document 

If the MU Personnel want to remove or submit a new or updated version of the required document, use the 
feature undo to complete the process. 

1. Locate desired document in list 

 

2. Click Select 

Submitted document  

4. Click OK 

2. Click Undo 

1. Click View document 

3. Locate file and double click file name 

2. Click Save, save as, or open as 
desired 

 
Choose where you are going to save 
the template 
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Only Ministry Unit Personnel with ARMS access or ARMS Coordinator can remove the previously submitted 
document and submit another one. The document file name will no longer be listed in the submitted documents 
until you submit a replacement for the required document.  

In order to submit a new version, follow the steps in Submit Review Documents. 

View Documents 
 If a document has been submitted by the Ministry Unit Personnel, it can be viewed by the Reviewers, Team 
Leader and Area Commander in View Documents. 

 

 

 

3. Click OK 

Open – opens document 
Save – saves document to downloads folder 
Save as – saves document to location of user choice 
Cancel – cancels the download process 
 
**If you select save as, you will have to select a 
location to save the document 

Click open, save or save as 

3. Click View Documents 

1. Click desired MU 

4. Click View Document 
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Ratings 

There are standard rating sheets with each review that must be completed by the reviewers. The sheets are 
available and will be maintained within the system. The reviewer must assign a rating to the ministry unit. If a 
rating other than Substantial (S) is assigned to a particular standard, a comment explaining the rating must be 
input. To achieve accreditation status, a total of 80% must be earned in each and every chapter.  

Weighting (whether the standard is regular, critical or high risk) serves as a factor in calculating the rating. The 
rating box presents the compliance scale providing choices for the reviewer. All ratings besides Substantial 
require the ministry unit to add a comment and formulate an action plan to improve the rating prior to the next 
scheduled review.  
 
 Rating                                                          

 
 

 
 
 
Risk 
             
 

 

 

 

Access Ratings 
ARMS reviewers are required to enter ratings for each of the standards for the chapters they have been assigned 
to complete for the review. 

S - Substantial – All requirements in the standard are met 

P - Partial – Many of the required elements are in place 

M - Minimal – Few of the requirements are met 

NC - Non-Compliant – Requirements are not fulfilled in any way 

NA - Not-Applicable – This rating is used when a standard does not 
apply to the situation or circumstance under review 

High risk outcomes  - Assigned a risk weight of 3 

Critical risk outcomes – Assigned a risk weight of  2 

Regular risk outcomes – Assigned a risk weight of 1 

All outcomes scored as substantial will 
receive full weight for that outcome. (eg: 
substantial high risk would be scored 3, 
substantial critical would be scored 2, 
and substantial regular would be scored 
1); If an outcome is assigned something 
other than substantial, the score would 
be less than full weight 
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If reviewers have not been assigned to chapters, and you try to access ratings, you will get a message similar to 
the messages below depending upon where you are in the review process. 

        

Complete Ratings 
ARMS Coordinators and Team Leaders will be able to see tabs for all chapters assigned to the review. 

 
A reviewer will only see tabs for the chapters they are responsible to review 

 
Reviewrs will enter ratings for all standards for the chapter. The information is saved automatically; if the reviewer 
select a rating other than S, a comment is required to save the rating. If the reviewer does not input a comment 
for a rating other than S, the data is not saved. To confirm all ratings and comments have been entered, click 
Refresh. 

1. Click to select the rating for each standard 
2. If rating is other than S, type a comment to 

explain why 

Chapters assigned reviewer 

Chapters ARMS Coordinator can view 

1. Click MU Name 

2. Click Ratings 
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When the page has been refreshed, if all ratings and required comments have been entered, you will see a check 
in ratings completed. If you do not get a check in this box after refreshing, review the standards to ensure all 
information has been entered. 

 
Complete the above process for each chapter assigned to you as a reviewer. ARMS auto saves the ratings as 
you work through the system, so it is possible to exit and re-enter the Rating Sheet. 

Print Details 
If you would like to print the summary sheets for the review, you can complete this process in Review Sheets and 
Scores. 

 

 

Refresh 

Click Print  

Click the link 

Ratings Completed 
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The file will open in Microsoft Excel; you can treat this as any Microsoft Excel document. 

Submit Ratings 
As a reviewer, you are responsible to complete ratings for each standard and for all chapters that have been 
assigned to you. All chapters assigned to the reviewer are to have completed ratings and required comments 
before the chapters can be submitted. Otherwise, the submit button is greyed out. 
You are to be in review ratings to submit the ratings. Once you have submitted review ratings, you will not be able 
to modify them.  

 

 

 
Scores can no longer be modified, and all ratings and comments are greyed out. 

 
The status on Accreditation Reviews page shows status as Chapter Rated. 

Click Submit  

Click Yes to confirm 

Open: opens the report 
Save: saves report to downloads 
Save as: save the report to location of choice 

There will be a check mark in ratings submitted and 
you will get a confirmation message that the ratings 
were submitted 
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Approve Ratings 
When all chapters have been rated by all reviewers, the ARMS Coordinator or the Team Leader will approve the 
ratings. You must be in Ratings to approve. You will see a check mark in Ratings Submitted; if you do not see this 
checked, you will not be able to approve the ratings. A team leader can modify the ratings before and after the 
ratings are approved. 

 
If all chapters have not been scored and submitted, you will get this message. 

 
When all chapters have been rated and submitted, you will successfully be able to approve the review. You will 
get this confirmation message.  

 
Click Refresh; you will see a check mark in Ratings Approved. 

 

Review Scores 
When all chapters have been rated, submitted, and approved, the ARMS Coordinator and Team Leader can view 
the scores. When the review has been closed, the Area Commanders are able to view the scores. The scores 
show the percentage for each chapter as well as the percentage for each of the different risks categories. 

Click Yes to confirm 

Click Ok to message and have reviewers 
proceed to score all chapters 

Click Approve  
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Access Scores 

 

 
 

Rating for reviews 
A chapter that has supplementary chapters, will only have one score displayed. This score is a calculated 
average which takes into account the main and supplementary ratings. The scores can be accessed after the 
ratings are submitted. In the ratings tab, after all the chapters have been completed, there is a “scores” tab to the 
right of the chapter tabs that shows the score of each chapter. The way you would show that there’s only one 
score for all of chapter 3 is to create a review with at least one supplementary chapter 3, and in the scores tab, 
you should be able to see the supplementary chapter tab but only one combined score.  

 

Release 

When the ARMS Coordinator is satisified with all aspects of the review, the review will be released.  

 

2. Click MU Name 

3. Click Ratings 

1. Click MU Name 

2. Click Release 
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The status will be updated on the reviews list page to Score Released.  

 

Action Plan 

After a review has been released, the Ministry Unit will review the ratings. The Ministry Unit personnel will be 
responsible for developing an action plan to address any standards that were not rated substantial or not-
applicable. 

If the action planner has not been assigned, the ratings have not been submitted and approved, or the review has 
not been released, individuals will not be able to access the action plan and will receive a message similar to the 
one below.  

  

 
Add Action Planner 

The Review Cordinator or the Team Leader can assign the action planner to the review. 

 
You will get a confirmation message that the action planner has been added to the review. 

3. Click Ok to confirm 

If you try to release a review that has already been 
released, you will get a message similar to below.  

2. Click Teams 

1. Select MU with scheduled review 
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Create Action Plan 

After the Ministry Unit Personnel responsible for the action plan has been assigned to the review, the ratings have 
been submitted and approved, he/she can access the action plan. 

The assigned action planner would log into the ARMS application and click Action Plan. 

 
If the action plan is not ready to access because all chapters have not been rated, or you have already submitted 
the action plan, you will get a message. 

                               
The ministry unit action planner will see the chapters that require an action plan. Each standard in the chapter that 
requires action will be listed.  

4. Click Save Action Plan Team 

3. Click to select Action Planner 
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Ministry Unit Submit Action Plan 
When you have entered an action step for each of the required standards, you can submit the action plan to DHQ. 

 

                            

The status is updated to show action plan submitted to DHQ. 

Click Submit 

Action step 

Click Yes 

You will get a message 
confirming action plan has been 
submitted and there will be a 
check mark in submit 

Input the action step information for each of the standards 
to address the comments from the reviewers. 
You may assign the action step to a specific person and 
create a target completion date if desired. However, in 
order to save, the action step is the only requirement; save 
happens automatically 

Action step 
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If you now go into action plan, everything is greyed out and cannot be edited. 

 

If you try to submit the action plan and have not completed all requirements for chapters of the action plan, you 
will get a message similar to below. Review the action plan to ensure each listed standard has a action step 
listed. 

 

If you are not a Ministry Unit action plan planner, a DHQ action plan reviewer, team lead for the review or an 
ARMS coordinator, you will not be able to access the action plan and will receive a message similar to the one 
below.  

 

Divisional Approval of Action Plan 
The DHQ action plan reviewer must appove the action plan so that it is then available to THQ team lead. If a team 
member attempts to access the action plan before it has been approved by the DHQ action plan approver, a 
message similar to the message below will be displayed. 

 
The DHQ action plan reviewer will select the Ministry Unit from the reviews list, and click action plan. The DHQ 
action plan reviewer will review the action plan as outlined by the Ministry Unit action planner and will approve the 
action plan. 
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The status is updated to show DHQ Approved. 

 
If you now go into action plan, everything is greyed out and cannot be edited. 

 
  

Click Yes 

Approve has a check mark and the date is displayed  
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Divisional Decline of Action Plan 

The DHQ action plan approver can decline the action plan outlined by the Ministry Unit if it is not 
satisfactory. 

 

                      

The status is updated to show DHQ Declined and further developement is required from the Ministry Unit on the 
action plan.  

 
Action plan standards can now be edited in preparation for resubmitting the action plan to DHQ. 

 
  

Open the action plan and click decline  

Click Yes 

Decline has a check mark and the date is displayed  
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Resubmit Action Plan to DHQ 
If the original action plan is not approved by DHQ personnel, the Ministry Unit can update the action plan based 
on comments froom DHQ. When the action planner has made the changes to the action plan as requested, the 
action plan can be resubmitted to DHQ for another assessement. 

 

            

The Accreditation Review list will be updated to indicate the action plan has been resumbitted to DHQ. 

 

The DHQ action plan reviewer will again review the action plan from the Ministry Unit and approve the plan by 
clicking the approve button. There will be an update to show the action plan was approved. 

 
  

Click Resubmit to DHQ 

Resubmit to DHQ has a check mark and the date is displayed  

Click Yes to confirm 
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THQ Approval of Action Plan 
When the DHQ action plan reviewer has approved the Ministry Unit action plan, the action plan will be available to 
the team lead for review and approval. 

When the DHQ action plan approver has approved the action plan, the Team Leader will select the Ministry Unit 
from the reviews list, and click action plan. The Team Leader will review the action plan as outlined by the Ministry 
Unit action plan planner and approved by the DHQ action plan reviewer. The Team Leader will approve the action 
plan. 

 

                 
The status is updated to show THQ Approved. 

 
  

Click Yes  

You will see a check mark in approve and the 
date it was approved 
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If you now go into action plan, everything is greyed out and cannot be edited. 

 
THQ Decline of Action Plan 
The THQ Team Leader can decline the action plan outlined by the Ministry Unit and approved by the DHQ action 
plan approver if it is not satisfactory. 

  

                      

The status is updated to show THQ Declined and further developement is required from the Ministry Unit on the 
action plan.  

  
Action plan standards can now be edited in preparation for resubmitting the action plan to THQ. 

 

Open the action plan and click decline  

You will see a check mark in decline and the date it was declined 

Click Yes 
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Resubmit Action Plan to THQ 
If the action plan is approved by DHQ and submitted to THQ, THQ can decline the action plan. When the action 
planner has made the changes to the action plan, the action plan can be resubmitted to THQ for another 
assessement. The action plan is submitted directly to THQ. 

  

             

 
 
Download Action Plan  
If you want to view the action plan outside of the application, it can be downloaded as an Excel file. 

1. Open the action plan by clicking Action Plan button 

Click Resubmit to THQ 

Resubmit to THQ has a check mark and the date is displayed  

Click Yes to confirm 
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The THQ Team Leader will again review the action plan from the Ministry Unit and approve the plan by clicking 
the approve button.  

                      

There will be an update to show the action plan was approved. 

 
  

2. Click Print  

3. Click the excel file name 

6. Open, save or select save as for excel file 
Open: Open file 
Save: saves to download folder automatically 
Save as: choose where to save file 

Click Yes  



 

66 | P a g e  

The status is updated to show THQ Approved. 

 

Action Plan Notes 
DHQ and THQ review team members can enter notes for the Ministry Unit if they want to question or make a 
recommendation on the action plan. The notes can then be viewed by Ministry Unit action plan planners. 
Create Action Plan Notes 
  

 

                 

 

The note is now available for Ministry Unit and THQ to view 

 
  

1. Open the action plan and click Note 2. Click Add new 

4. Click Save 
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Edit Action Plan Notes 
Action plan notes can be edited by the individual that created the note. No person can edit notes created by 
another person. 

 

 

You will now be able to view your changes to notes 

 
  

1. Open the action plan and click Note 

2. Click Edit 

4. Click Update 
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View Action Plan Notes 
The Ministry Unit, DHQ and THQ can view action plan notes. DHQ and THQ can enter action plan notes but the 
Ministry Unit cannot. 

 
 
Print Action Plan Notes 
All review team members can print the action plan notes. 

 

             
  

1. Open the action plan and click Note 
2. View each desired note 
3. Click X to close notes 

3. Click Print  

5. Click Print  

4. Select printer 

1. Open the action plan and click Note 
2. Click Print Preview 
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Delete Action Plan Notes 
Action plan notes can be deleted by the individual that created the note. No person can delete notes created by 
another person. 

 

 

  

Close Review 

When the team lead has approved the action plan for the Ministry Unit, the ARMS Coordinator will close the 
review. From the Accreditation reviews page, click Close. 

 

                          
  

1. Open the action plan and click Note 

3. Click OK 

Click OK  

You will get this message while the close is finalized 
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When the process is completed you will see an update on the conditional pass review page. 

 
If you try to close a review that is already closed, you will receive a message similar to the one below.  

      
If a Ministry Unit qualifies for the conditional pass process, the review cannot be closed until a decision has been 
made regarding the conditional pass offered. When the ARMS Coordinator attempts to close the review, they will 
receive a message that the Ministry Unit is eligible for a conditional review.  

 

Conditional Pass 
A conditional pass offers the ministry unit another chance to gain accreditation. It is a process that occurs 
between the Ministry Unit and THQ. DHQ is not involved in the conditional pass process unless a member of 
DHQ is a reviewer assigned to the conditional pass. 

Requirements of a Conditional Pass 
To receive accreditation status during a review, the Ministry Unit is required to attain eighty percent or higher in 
each chapter it has been rated. If these ratings are not achieved, a conditional pass may be offered to the Ministry 
Unit. To be offered a conditional pass, the Ministry Unit will have scored between seventy and eighty percent on 
no more than two chapters in which the unit was evaluated during the accreditation review. If a Ministry Unit 
scored less than seventy percent on any chapter or they scored less than eighty percent on three or more 
chapters, no conditional review is offered to the Ministry Unit. 

Accept Conditional Pass 
If a Ministry Unit does not meet required standards for accreditation following a review but qualifies for a 
conditional review, they will be able to view this option from the review list screen when they log into ARMS. The 
status will show Conditional Pass Offered.  

 
Upon clicking the arrow, the view is expanded to show the details of the original review. If the Ministry Unit wants 
to accept the offer of conditional pass, they will inform the accreditation coordinator at THQ. 
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When the ARMS coordinator assigned to the review has been notified of the Ministry Unit’s decision to accept the 
conditional review offer, that individual will make the selection in the ARMS application and begin the process of 
preparing for the conditional review. 

 

 

 

                                                                             

 

Conditional Review Process 
The ARMS Coordinator will schedule a time for the review and select a reviewer(s) for the chapter(s) that the 
Ministry Unit scored between seventy and eighty percent on. The process then begins again for the reviewer(s) to 
rate the standards that the Ministry Unit did not meet the requirements for in the original review. 

The conditional review is an interaction between the Ministry Unit and THQ; DHQ is no longer a part of this 
process. There is also no opportunity for the Ministry Unit to create another action plan if all standards are not 
rated as substantial. The reviewer(s) will complete and submit the ratings. The ARMS Coordinator will approve 
the ratings and close the review. 

From the menu, click Workflow, Conditional Pass Review. The ARMS Coordinator will schedule a date for the 
conditional review and select reviewers for the conditional review. The reviewers will rate and submit the 
chapter(s) that the Ministry Unit did not meet the standards. Then the ARMS Coordinator will close the review as 
per usual. 

1. Click Workflow>Conditional Pass Review 

2. Click drop-down to select accept 

3. Click OK to confirm accept 

4. Status shows conditional 
pass accepted and in 
progress 
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Displayed on the reviews home screen, if you click the arrow in front of desired Ministry Unit, you will see the 
history for the original review, the conditional pass review and the updated review results after the conditional 
pass. 

Click desired review and click the ratings button to view the scores for the selected review. 

 

Decline Conditional Pass 
A Ministry Unit is not required to accept the conditional pass offer. If they choose to decline the offer, they will 
inform the THQ coordinator; the THQ coordinator will select decline on the conditional pass and the scores from 
the original review will remain in effect. The process is now final. 

                                                                      

                

Schedule Tracking 
The schedule tracking process is carried out by ARMS Coordinator or Review Scheduler. It tracks the dates of the 
administrative tasks that have to be completed during the review process. Many of the dates are predetermined 
and autocompleted based on the review date and can be checked off once completed. 

Access Schedule Tracking 

 

Prefilled Dates 
Notification letter – 12 weeks prior to review date 
Reminder notice – 7 weeks prior to review date 
Materials due – 5 weeks prior to review date 
E-Mail documents– 2 weeks prior to review date 

Click Workflow  

When the review is closed, the 
status is updated to Accepted 

Click OK to dismiss the message The status shows as declined 

Click Schedule Tracking 
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Mailing summary – 3 weeks after review date 
Action plan reminder - 12 weeks after review date 
Action plan received - 15 weeks after review date 

Confirm dates 
There is a confirm date column to indicate that the information has been completed and/or mailed for many of the 
prefilled dates. These include:  
Notification letter date     Mailing summary sent date 
Reminder notice date                             Action plan reminder sent date 
Materials sent date                                 Action Plan received date 
Email documents sent date      
Locate the desired Ministry Unit by using the search fields 
Note: When you type into the search field, you have to click the mouse off that field to activate the search 
The actual dates can be completed manually. The prefilled dates can also be modified 
Click the date field to change it.                                              

 

 

Reports 
The ARMS application has a variety of reports available. The reports include Ministry Unit reports, summary 
reports and business intelligence reports. The report format is Microsoft Excel and may be treated as any Excel 
file.  

The summary sheet reports will have the ratings and comments for each individual standard in a review. The 
final scores report will include the percentage score given to each chapter in a review.  

  

1. Type date or select date from calendar 

2. Click Save 

1. Type new prefilled date or select date from calendar 

2. Click Save 
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Ministry Unit Reports 
The Ministry Unit reports are automatically generated when the review is released and closed. There are four 
reports for each review; two final reports for rating and scores following the close of the review and two released 
reports for rating and scores following the release of the scores for the review. 

               

  

 
  

1. Click Reports>Ministry Unit 

2. Search for the Ministry Unit 
3. Click Download on desired report 

4. Click to open, save or save as 
 
Open: opens the report 
Save: saves report to downloads 
Save as: save the report to location of choice 

Search 
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Release Rating/Close Rating 

The release rating and close rating shows the ratings and comments for each standard in each chapter evaluated 
in the review. There may be changes in the ratings from when the scores are released and when the review is 
closed. The final rating represents the final results in the review. 

 
  

Chapters 
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Release Score/Close Score 

The release scores and close scores show the scores for each chapter evaluated in the review. There may be 
changes to ratings from the release of a review to the close of a review which may change the scores for the 
review. The final scores represent the final results in the review. 

 

Summary 
Summary reports offer review overviews. The default displays data from across the territory. However, the data 
can be filtered for specific divisions, specific ministry units, review cycles, and date ranges. The score threshold 
filters the data based on changing the required accreditation rating for success. The data is displayed using table 
format, pie charts, and bar charts. 

 
Filter the data if desired to limit the data displayed. If no ministry unit within the division has had a review, that 
division will not be visible in the drop-down; likewise if there have been reviews within the division, but a ministry 
unit is not listed in the drop-down, that ministry unit has not had a review. 

You can filter the data based on date ranges if desired. If you do not input an end date, it assumes the end date to 
be current date. You may use multiple filters to limit the data. 

  

1. Click Reports>Summary 
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Click drop-down to filter by Divisions, Ministry Units and/or select the review cycles. 

 
Type desired dates or click on the calendar icon to select desired start and end dates for filter. 

 
Drag the slider on threshold to view results if success criteria were changed. 

          

Business Intelligence Reports 
Business Intelligence reports provide a means for analytical data and comparison. The reports may be 
customized by selecting from a list of available fields to make them active fields and display on the report. 

 
To elect what is appearing on the reports, choose the available fields and drag them to selected fields 

 

1. Click Reports>Business Intelligence 

Available fields 

Selected fields 

Click the field in available fields and with the 
mouse still suppressed, drag the available field to 
the selected fields. Selected fields appear on the 
report 
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Example report based on the selected criteria above 

Selected fields are the labels for the report. 

 
Both the available fields and the selected fields may be filtered to limit the data displayed by using the drop-down. 

          
Default filter (all selected)                                                  Filtered for one division only (OCE) 

                           
  

Filter 

Click apply to engage filter 
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The data columns may be changed by dragging the available fields to the top of the report across from the 
functions. 

 
The data display is modified based on columns and rows from above filtering. 

Example of column filtering based on Division Name 

 
Example of column filtering based on Division Name and Ministry Unit Name 

 
The drop-down at the top of the report selection criteria are Excel based functions and behave in standard excel 
format. 

 
Print Reports 
You can print the reports that you generate. Ministry Unit reports are generated in Microsoft Excel so you can 
print these as in any Excel spreadsheet. When you click the print icon for Summary or Business Intelligence 
reports, a screen capture of what you have filtered if anything is printed.  

Click Print icon to generate the screen capture of the information displayed on screen. 

 

Report criteria 

Selected field 
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Create Live Reports 
ARMS reports may be generated by connecting to a SQL data source. The benefit of this type of report is the data 
is pulled from the application source and it is always the most up-to-date information. The report is created using 
Microsoft Excel; therefore the data output can be treated and data in any excel spreadsheet and provides all 
functions available in Excel. 

CONNECT TO A SQL DATA SOURCE 

1. Open Excel 
2. Click Data>From Other Sources>From SQL Server 

 
3. Enter the Server name ontorthqdb064 
4. Confirm Use Windows Authentication is selected 
5. Click Next 

 
6. Select database ARMS_PROD 
7. Click Next 
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8. Confirm Connect to a specific table is checked 
9. Click ReviewHistoryView 
10. Click Next 

 
11. Give the data connection a file name 
12. Ensure Always attempt to use this file to refresh data is checked 
13. Click Finish 

 
14. Ensure Table is selected 
15. Ensure Existing worksheet is selected 
16. Click OK 
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The data table will be displayed 

 

INSERT A PIVOT TABLE 

1. Open the data source in Excel 
2. Click Insert>PivotTable>PivotTable 

 
3. Ensure Select a table or range is selected 
4. Select the desired data from the worksheet 
5. Ensure New worksheet is selected 
6. Click OK 
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7. Click to check pivot table field List 
8. Click to drag the Row Labels to Values 
9. Click drop-down arrow on Values 

 
10. Select Value Field Settings….  
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11. Select the desired Summarize value field by 
12. Click Number Format 

 
13. Select the desired number format 
14. Click OK 

 
15. Click OK 
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Data is displayed as selected for the pivot table 

 

Calendar 
The calendar provides an easy way to view scheduled reviews. You cannot modify calendar entries in this view. 
You will only be able to see the reviews assigned to you in the calendar view. 

 
  

Click Tools>Calendar 
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Click more to get a timeframe view 

 

 

Calendar Controls 

 
Click calendar icon                                                 Calendar displays 

                                                                        

Previous quarter Future quarter 

All day 

Less than all day 

Tomorrow 
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Sort 
Sorting means you can change the order in which items are displayed. Labels are used as sorting fields. Typically 
you can sort alphabetically and numerically. You can click the label name to sort. You can only sort on one field at 
a time. In ARMS you can sort on many different screens.  
 
Reviews List 

 

Filters 
Filters are used to make it easier to find information. When you filter information, you search text that fit a certain 
criteria. In ARMS you can filter on many different screens. Any screen where you see a text box below the label or 
there is a drop-down, you can filter on that field. You can filter on more than one field at a time. 

Text Box Filters 

 
 
  

Click OK 

1. Type desired information into text box 
2. Click ENTER on keyboard 
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Example of part of word for search 

 
 
Example of entire word for search 

 
 
As well you can use more than one filter at a time. 
 
Example of using more than one filter 

 

Remove Filter 
To remove the filter, you can highlight the contents of the filter, and press Delete on the keyboard or you can click 
the x in the filter field. Then press Enter on keyboard.  
                                  

                      
  

Click X 
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Page Controls 

At the bottom of the documents maintenance page you will see page controls for displayed page. 

Move through Individual pages 

 

Go To Desired Page 

 

Go to First or Last Page 

 

Page Size 

You can change the number of records that display on a single page. Click drop-down arrow to select the number 
of records to display on the page.  

 

Items and Pages Displayed 
On the far bottom right of the display page you will see the number of items displayed on the page as well as the 
number of pages available. 

  

Click desired page number 
 

Go to last page 
 

Number of records to display 
 

Number of items/pages to displayed 
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Sign Out 

 

Click Sign Out 
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